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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide 

Welcome to HP Business Process Testing for SAP Applications. Business 
Process Testing for SAP Applications adds functionality to HP Quality Center 
and HP Business Process Testing that enables you to test SAP applications.

Note: This guide assumes familiarity with standard Business Process Testing 
concepts and functionality. For more information on working with Business 
Process Testing, refer to the HP Business Process Testing User’s Guide.

How This Guide is Organized

The HP Business Process Testing for SAP Applications User’s Guide describes 
how to use Business Process Testing to test SAP applications. It explains how 
to create and manage flows, add flow parameters and run conditions, learn 
flows automatically, detect and update changes, and work with the 
Application Model module.

It contains the following chapters:

Chapter 1 Introducing Business Process Testing for SAP Applications

Provides a conceptual overview of flows, and an introduction to using 
Business Process Testing for SAP applications.

Chapter 2 Working With Flows

Describes how to create and develop flows, and how to use flows to build 
business process tests.
7



Welcome to This Guide
Chapter 3 Working with Flow Parameters

Describes how to use flow input and output parameters to increase the 
flexibility and reusability of your business process tests.

Chapter 4 Learning Flows

Describes how to learn a flow automatically by navigating your SAP 
application.

Chapter 5 Defining Run Conditions

Describes how to add run conditions to your flows, enabling you to run 
business components selectively, depending on parameter values of 
previous business components in a flow.

Chapter 6 Detecting and Resolving Changes

Describes how you can detect changes in your SAP application that 
necessitate modifications to your flows, and how you can instruct Business 
Process Testing for SAP Applications to make these modifications 
automatically.

Chapter 7 Working with Application Model Entities in Quality Center

Describes how to work with the Application Model, which enables you to 
model your SAP application hierarchy within Quality Center.

Documentation Library

The Documentation Library is an online help system that describes how to 
use Quality Center. You can access the Documentation Library in the 
following ways:

➤ Click Documentation Library in the Quality Center Help menu to open the 
Documentation Library home page. The home page provides quick links to 
the main help topics.

➤ Click Help on this page in the Quality Center Help menu to open the 
Documentation Library to the topic that describes the current page.
8
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Welcome to This Guide
Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site (http://
www.adobe.com).

Getting Started explains how to use the Documentation Library and how it 
is organized. (Available online.)

What’s New? describes the newest features in the latest version of Quality 
Center. (Available online and in PDF format.)

You can also access What’s New? from the Quality Center Help menu. In 
addition, you can choose Help > Product Feature Movies to view short 
movies that demonstrate the main product features. 

Readme provides last-minute news and information about Quality Center. 

Quality Center Guides

HP Quality Center User’s Guide explains how to use Quality Center to 
organize and execute all phases of the testing process. It describes how to 
define requirements, plan tests, run tests, and track defects. (Available 
online and in PDF format.)

HP Quality Center Administrator’s Guide explains how to create and 
maintain projects using Site Administration, and how to customize projects 
using Project Customization. (Available online and in PDF format.)

HP Quality Center Tutorial is a self-paced guide teaching you how to use 
Quality Center to manage the software testing process. (Available in PDF 
format.)

HP Quality Center Installation Guide explains how to install Quality Center 
on a server machine in a cluster environment or as a stand-alone 
application. (Available in PDF format.)

Business Process Testing Guides

HP Business Process Testing User’s Guide explains how to use Business 
Process Testing to create business process tests. (Available online and in PDF 
format.)
9
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Welcome to This Guide
HP Business Process Testing Tutorial provides a self-paced guide that teaches 
you the basics of Business Process Testing in the Quality Center application. 
(Available in PDF format.)

API References

HP Quality Center Database Reference provides a complete online reference 
for the project database tables and fields. (Available online.)

HP Quality Center Open Test Architecture API Reference provides a 
complete online reference for the Quality Center COM-based API. You can 
use the Quality Center open test architecture to integrate your own 
configuration management, defect tracking, and home-grown testing tools 
with a Quality Center project. (Available online.)

HP Quality Center Site Administration API Reference provides a complete 
online reference for the Site Administration COM-based API. You can use 
the Site Administration API to enable your application to organize, manage, 
and maintain Quality Center users, projects, domains, connections, and site 
configuration parameters. (Available online.)

HP Quality Center Custom Test Type Guide provides a complete online 
guide for creating your own testing tool and integrating it into the Quality 
Center environment. (Available online.)

Additional Online Resources

Mercury Tours sample Web site is the basis for many examples in this guide. 
The URL for this Web site is newtours.demoaut.com.

Knowledge Base opens directly to the Knowledge Base landing page on the 
Mercury Customer Support Web site. Choose Help > Knowledge Base. The 
URL for this Web site is support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp.
10
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Welcome to This Guide
Customer Support Web site accesses the HP Software Support Web site. This 
site enables you to browse the Support Knowledge Base and add your own 
articles. You can also post to and search user discussion forums, submit 
support requests, download patches and updated documentation, and more. 
Choose Help > Customer Support Web site. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

Send Feedback enables you to send online feedback about QuickTest 
Professional to the product team. Choose Help > Send Feedback.

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.
11
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Welcome to This Guide
Typographical Conventions

This guide uses the following typographical conventions:

UI Elements and 
Function Names

This style indicates the names of interface elements on 
which you perform actions, file names or paths, and 
other items that require emphasis. For example, “Click 
the Save button.” It also indicates method or function 
names. For example, "The wait_window statement has 
the following parameters:"

Arguments This style indicates method, property, or function 
arguments and book titles. For example, “Refer to the 
HP User’s Guide.”

<Replace Value> Angle brackets enclose a part of a file path or URL 
address that should be replaced with an actual value. 
For example, <MyProduct installation folder>\bin.

Example This style is used for examples and text that is to be 
typed literally. For example, “Type Hello in the edit 
box.”

CTRL+C This style indicates keyboard keys. For example, “Press 
ENTER.”

[ ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument. 

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. In a 
programming example, an ellipsis is used to indicate 
lines of a program that were intentionally omitted.

| A vertical bar indicates that one of the options 
separated by the bar should be selected.
12
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1
Introducing Business Process Testing for 
SAP Applications

This chapter provides an overview of working with Business Process Testing 
for SAP Applications. It introduces the concept of flows, which are central to 
working with Business Process Testing for SAP Applications. It also describes 
a typical workflow for working with Business Process Testing for SAP 
Applications.

Note: For information on installing and setting up Business Process Testing 
for SAP Applications, and on configuring user permissions, see the HP 
Business Process Testing for SAP Applications Installation Guide.

This chapter includes:

 ➤  About Business Process Testing for SAP Applications on page 14

 ➤  What is a Flow? on page 16

 ➤  Business Process Testing for SAP Applications Workflow on page 18
13
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About Business Process Testing for SAP Applications

Business Process Testing for SAP Applications provides additional 
functionality to Business Process Testing for use with SAP applications. This 
guide describes this additional functionality. For more details on the 
standard Business Process Testing functionality, see the HP Business Process 
Testing User’s Guide.

Business Process Testing for SAP Applications enables you to create flows in 
the Test Plan module. A flow is type of test that is a collection of business 
components in a fixed sequence that you can use in multiple business 
process tests. You can increase the reusability of flows by adding flow 
parameters, in a similar way to adding parameters for business components. 
In addition, you can use run conditions to enhance the flexibility of a flow 
by enabling components to run selectively, based on earlier stages within 
the flow. For more information on flows, see “What is a Flow?” on page 16.

In addition, if you are working with an SAP application and have QuickTest 
Professional installed with the SAP Add-in, Business Process Testing for SAP 
Applications enables you to learn the actions you perform on your SAP 
application and generate a flow containing automated components based 
on these operations. Business components are generated within the flow, 
based on the screens and transactions within your SAP application. This 
enables a Subject Matter Expert, who has a detailed knowledge of SAP 
systems, to create automated components for testing SAP applications. The 
Subject Matter Expert can create these automated components without the 
involvement of an Automation Engineer, who is an expert in programming 
and automated testing.

Business Process Testing for SAP Applications also enables you to run flows 
and tests on an SAP application in change detection mode. This enables you 
to determine how the application has changed since the flow or test was 
built, such as whether controls in the user interface were added or deleted. 
For each change detected, Business Process Testing for SAP Applications 
offers you a choice of ways to resolve the change, such as opening a defect 
or removing a step from one of the components in the flow or test. Change 
detection and resolution simplify component maintenance, thereby 
reducing the effort needed to invest in automated testing.
14
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Chapter 1 • Introducing Business Process Testing for SAP Applications
Business Process Testing for SAP Applications also includes the Application 
Model module. You can import the application entity hierarchy from your 
SAP application to the Application Model module, enabling you to model 
your SAP application within Quality Center. You can then associate entities 
in the Application Model module with tests, flows, and business 
components, enabling you to plan your testing process based on the 
application entity hierarchy. For more information on the Application 
Model module, see Chapter 7, “Working with Application Model Entities in 
Quality Center.”

Configuring QuickTest Professional to Work with Business 
Process Testing for SAP Applications
A number of options are recommended to, or must be set in QuickTest to 
take advantage of all Business Process Testing for SAP Applications features. 

To enable QuickTest to work with Business Process Testing for SAP 
Applications:

 1 Open QuickTest. Select Tools > Options and click the Run tab. Ensure that 
the Allow other HP products to run tests and components check box is 
checked.

To configure QuickTest to take advantage of all Business Process Testing for 
SAP Applications features:

 1 Open QuickTest. Select Start > QuickTest Professional > QuickTest 
Professional.

 2 Select Tools > Options and click the SAP tab. 

➤ Under SAP GUI for Windows > Record settings ensure that:

➤ the Auto-parameterize table and grid controls check box is checked.

➤ the Record only the selected value when using a Possible Entries (F4) 
list check box is checked. 

➤ Under SAP GUI for Windows > Run settings ensure that the Session 
cleanup check box is unchecked.
15
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Chapter 1 • Introducing Business Process Testing for SAP Applications
 3 If your SAP application contains objects from environments other that SAP 
and Web, you need to configure Business Process Testing for SAP 
Applications to recognize these objects.

 a Open the Bpt4ErpCrmCfg.xml file in the Dat folder of your QuickTest 
Professional installation folder.

 b Add the following line to the Settings section:

<Config name="additional_addins" value="add-in name"/>

Where the add-in name is the name of the add-in as it appears in the 
Add-in Manager of QuickTest Professional. You separate multiple add-ins 
with a semi-colon, with no additional spaces. 

For example <Config name="additional_addins" value="Java;ActiveX"/>

Note: Only users who are comfortable editing XML files should perform 
this operation.

What is a Flow?

A flow is a reusable collection of business components. You can combine 
components into a sequence, or flow, and then use that flow in multiple 
business process tests. Flows also provide a single point of maintenance. 
When you modify a flow or any of its components, all business process tests 
containing that flow reflect that modification.

For example, suppose you are creating business process tests that test various 
shopping scenarios in a grocery shopping application. Some of your tests 
might contain one or more of the following sub-processes:

➤ registering for the site and logging in

➤ searching for items

➤ reading customer reviews

➤ viewing the shopping list from past purchases

➤ adding items to the shopping cart

➤ viewing the shopping cart

➤ proceeding to checkout
16
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Chapter 1 • Introducing Business Process Testing for SAP Applications
➤ purchasing items (payment details)

➤ confirming or modifying personal profile details, such as the delivery 
address

➤ logging out of the site

You would create at least one component for each sub-process in a test. For 
sub-processes that change depending on the scenario, you might create 
multiple components. For example, when purchasing items, a user might 
want to pay by credit card or request to receive a bill in the mail. You could 
create a component for each of these scenarios.

Some of your business process tests might contain several components that 
logically follow one another. For example, any test that includes a 
purchasing scenario might include a component for proceeding to 
checkout, a component for inserting payment instructions, and a 
component for verifying the customer’s personal profile details. By grouping 
these components into a single flow and using parameters to change the 
input and output values during each flow iteration, you can reuse these 
components more efficiently across multiple business process tests.

Maintaining business process tests may require adding, modifying, moving, 
and removing components. For example, you may need to insert a new 
component that checks the user's payment history according to the credit 
card number entered. You can include this new component in your existing 
flow to automatically update all of the relevant business process tests at 
once instead of inserting the component separately in each of your tests.

For more information on creating and managing flows, see Chapter 2, 
“Working With Flows.”
17
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Chapter 1 • Introducing Business Process Testing for SAP Applications
Business Process Testing for SAP Applications Workflow

This section provides an example of a common workflow using Business 
Process Testing for SAP Applications, including automatic learning of flows. 
The actual workflow in an organization may differ for different projects, or 
at different stages of the application development life cycle. All stages in this 
workflow can be performed by a Subject Matter Expert, without the 
involvement of an Automation Expert.

The workflow consists of the following stages: 

C reate
F low s

Learn  F low s

B uild  Test from
Learned  F low s

R un  Test in
C hange D etection  

M ode

R eso lve
C hanges

Im port A pp lication  
H ierarchy
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Chapter 1 • Introducing Business Process Testing for SAP Applications
Importing the Application Hierarchy
The Application Model module enables you to manage a hierarchical 
representation of the entities in your SAP application. You can choose to 
import entities from your SAP application, and add and modify application 
entities and folders. This enables Business Process Testing for SAP 
Applications to create associations automatically between application 
entities in the Application Model module and the business components 
created when learning flows automatically.

For more information on importing the application hierarchy, see 
Chapter 7, “Working with Application Model Entities in Quality Center.”

Creating Flows
You create flows in the Test Plan module. You can provide details to the 
flow, such as a description and comments. You can also assign attachments 
to the flow, and associate the flow with other Quality Center records, such 
as requirements, defects, and application entities. In addition, you can 
create and configure manual and automatic business components and add 
them to the flow.

For more information, see Chapter 2, “Working With Flows.”

Learning Flows
Business Process Testing for SAP Applications offers the option to learn flows 
automatically as you navigate your SAP application. Business Process Testing 
for SAP Applications creates automated business components corresponding 
to screens and transactions in your SAP application, and creates component 
steps based on the operations you perform. These components are then 
added to the flow. During the learning process you can insert checkpoints 
and output values.

When you learn flows, Business Process Testing for SAP Applications 
automatically creates component input parameters for controls in the SAP 
user interface that require user input, such as text fields. The default value 
for these parameters is the value you insert in these fields during the learn 
flow process.

For more information, see Chapter 4, “Learning Flows.”
19
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Building Tests from Flows
You build a business process test based on the flows learned automatically. 
In addition, you can include other flows, and manual and automatic 
business components.

For more information, see “Adding Flows to Business Process Tests” on 
page 29.

Running Tests in Change Detection Mode
If your test includes flows learned automatically, you can run the test in 
change detection mode. When you run a test in change detection mode, 
Business Process Testing for SAP Applications checks whether elements in 
your SAP application have changed since the flow was learned. This enables 
you to later update your flows to reflect these changes.

For more information on detecting changes, see “Detecting Changes” on 
page 70.

Resolving Changes
When a test or flow that ran in change detection mode is complete, you can 
view a report detailing the status of each flow, business component, and 
component step in your test, including whether objects used in your steps 
have changed in your SAP application. If changes were detected during the 
test run, you are offered a variety of options for resolving them, such as 
removing an obsolete step from a component, or reporting a defect.

After you resolve the changes and update your flows and tests, you can run 
additional testing cycles to further test your SAP application.

For more information on resolving changes, see “Resolving Changes” on 
page 83.
20
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2
Working With Flows

This chapter describes how to create, build, and manage flows, and how to 
add flows to business process tests.

This chapter includes:

 ➤  About Working With Flows on page 21

 ➤  Creating Flows on page 22

 ➤  Developing Flows on page 23

 ➤  Viewing Flow Details on page 24

 ➤  Understanding the Test Script Tab on page 26

 ➤  Building Flow Structure on page 27

 ➤  Managing Flows on page 29

 ➤  Adding Flows to Business Process Tests on page 29

About Working With Flows

A flow is a collection of business components in a fixed sequence that can 
be used as a unit in different business process tests. This provides you with a 
unit that can be maintained in only one place, but which you can use as a 
building block in multiple tests. You work with flows in the Test Plan 
module.
21



Chapter 2 • Working With Flows
After you create a flow, you develop it by providing flow details, adding 
attachments, and creating associations between the flow and other Quality 
Center records, such as requirements, defects, and application entities. 
These associations provide real-time visibility into modifications for 
interrelated, application-quality elements.

You build a flow by adding existing components to it, by adding component 
requests, or by learning the flow automatically by navigating your SAP 
application. When your flow is ready, you can add it to business process 
tests, together with other flows and business components.

Note: The permission settings for a user group for working with flows are 
the same as those for the user group for working with tests. For more 
information on configuring user group permission settings, refer to the 
HP Quality Center Administrator’s Guide.

Creating Flows

You create flows within the Test Plan Tree in the Test Plan module.

To create a flow:

 1 If the Test Plan module is not open, click the Test Plan button on the 
sidebar. The Test Plan module opens.

 2 If the Test Plan Tree is not displayed, choose View > Test Plan Tree.

 3 Select the folder in the Test Plan Tree in which you want to create the flow 
and click the New Test button. The Create New Test dialog box opens.
22
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Chapter 2 • Working With Flows
 4 In the Test Type box, select FLOW.

 5 In the Test Name box, type a name for the flow.

 6 Click OK. The flow is added to the selected folder in the Test Plan Tree.

Developing Flows

After you create a flow, you can use the following tabs to plan and design 
the flow:

➤ Details tab. Enables you to view and modify flow details. For more 
information, see “Viewing Flow Details” on page 24.

➤ Test Script tab. Enables you to build the structure of the flow by selected one 
or more business components and adding them to the flow, or by learning 
the flow automatically by navigating your SAP application. For more 
information, see “Understanding the Test Script Tab” on page 26.

➤ Attachments tab. Enables you to associate the flow with a file, a URL, a 
screenshot, system information, or the content of the clipboard. For more 
information on working with attachments, see the HP Quality Center User’s 
Guide.

➤ Req Coverage tab. Enables you to associate the flow with requirements. You 
create requirements coverage for a flow in the same way as you would for a 
test. For more information, see the HP Quality Center User’s Guide.

➤ Linked Defects tab. Enables you to link the flow with existing defects, or to 
create a new defect and link it to the flow. For more information on defect 
linkage, see the HP Quality Center User’s Guide.

➤ Application Entities tab. Enables you to associate the flow with this  
application entities stored in the Application Model module. These entities  
represent elements of your SAP application hierarchy. For more information 
on the Application Model module, see Chapter 7, “Working with 
Application Model Entities in Quality Center.”
23
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Viewing Flow Details

You can view and modify details for a flow by selecting the flow in the Test 
Plan Tree and clicking the Details tab.

The following table describes the fields and tabs displayed in the Details tab:

Field/Tab Description

Test ID A unique numeric ID assigned by Quality Center 
to the flow. This field is read-only.

Test Name The flow’s name. This field is read-only in the 
Details tab, but you can rename a flow by 
right-clicking the flow in the Test Plan Tree, 
choosing Rename, and typing the new name.
24
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Status The flow’s status, determined by the statuses of 
the business components in the flow. The 
following statuses are possible:

➤ Ready. All the components in the flow have 
status Ready.

➤ Maintenance. At least one component in the 
flow has status Under Development or 
Maintenance, and no components have status 
Error or are obsolete.

➤ Error. At least one component in the flow has 
status Error, and no components are obsolete.

➤ Outdated. At least one component in the flow 
is obsolete.

For more details on statuses for business 
components, refer to the HP Business Process 
Testing User’s Guide.

Designer The designer of the flow. Must be one of the 
Quality Center users assigned to the project.

Creation Date The date on which the flow was created.

Description A description of the flow.

Comments Comments on the flow. You can click the Add 
Comment button to add a new comment, 
including the current date and name of the 
current user.

Field/Tab Description
25
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Understanding the Test Script Tab

The Test Script tab enables you to build the structure of a flow by adding one 
or more business components to the flow, or by learning the flow 
automatically. You can also use the tab to configure values for component 
parameters, define flow parameters and their default values, add run 
conditions to the flow, validate the flow, run the flow in debug mode, and 
generate business component requests.

Most of the functionality available in the Test Script tab for flows is the same 
as that available for business process tests. For more information on this 
functionality, see the HP Business Process Testing User’s Guide.

In addition to the standard functionality available for business process tests, 
the Test Script tab for flows includes the following toolbar buttons:

➤ Learn Flow. Enables you to learn a flow automatically by navigating your 
SAP application. For more information, see Chapter 4, “Learning Flows.”

➤ Flow Input Parameters. Enables you to define default values for your flow 
input parameters. For more information, see “Defining Default Flow Input 
Parameter Values” on page 40.

➤ Flow Output Parameters. Enables you to define flow output parameters. For 
more information, see “Defining Flow Output Parameters” on page 41.
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➤ Add Run Condition. Enables you to add a run condition to your flow. For 
more information, see “Adding Run Conditions” on page 64.

➤ Remove Run Condition. Enables you to remove an existing run condition 
from your flow. For more information, see “Removing Run Conditions” on 
page 68.

Building Flow Structure

A flow consists of a sequence of one or more business components. You 
build the structure of a flow by selecting the business components from the 
Component Tree and adding them to the flow.

Notes:

➤ In addition to manually adding existing business components to a flow, 
you can create a flow comprising components created automatically by 
recording your actions as you navigate an SAP application. For more 
information, see Chapter 4, “Learning Flows.”

➤ You can group components in a flow as you would for business process 
tests. However, it is recommended that you do not group components in 
a flow for compatibility with future versions of Business Process Testing 
for SAP Applications.
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To build a flow:

 1 In the Test Plan Tree, select the flow to which you want to add components 
and click the Test Script tab. The Test Script tab displays the components 
currently in the flow.

 2 Click the Select Component button. The Component Tree opens in the 
right pane.

Tip: In addition to adding existing components to your flow from the 
Component Tree, you can add a component request. A component request 
acts as a signal to add a new business component to the Business 
Components module. You add component requests to a flow as you would 
for a business process test. For more information on component requests, 
refer to the HP Business Process Testing User’s Guide.

 3 In the Component Tree, expand the folder containing the business 
component that you want to add to the flow.
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 4 In the Component Tree, select the component that you want to add to the 
flow and click the Add Component to Test button. Alternatively, drag the 
component into the Test Script pane.

 5 To add additional components to the flow, repeat steps 3 and 4 for each 
additional component.

 6 Use the Move Component Up and Move Component Down buttons to 
arrange the components in the test in the correct order. Alternatively, click 
the gray sidebar to the left of a component and drag the component to the 
correct position.

 7 You can add flow parameters and run conditions to increase the flexibility of 
your flow. For more information on flow parameters, see Chapter 3, 
“Working with Flow Parameters.” For more information on run conditions, 
see Chapter 5, “Defining Run Conditions.”

Managing Flows

You can cut, copy, paste, rename, delete, and validate flows. You perform 
these actions for flows in the same way as you would for business process 
tests. For more information on performing these actions for business process 
tests, refer to the HP Business Process Testing User’s Guide.

Adding Flows to Business Process Tests

You can use flows in business process tests. A business process test can 
comprise only business components, only flows, or a combination of 
business components and flows. This section describes how to add flows to 
business process tests. For more information on adding business 
components to business process tests, see the HP Business Process Testing 
User’s Guide.

To add a flow to a business process test:

 1 In the Test Plan Tree, select the business process test to which you want to 
add a flow and click the Test Script tab. The Test Script tab displays the 
components and flows that are currently in the business process test.
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 2 Click the Select Component arrow and select Select Flow. The Test Plan Tree 
opens in the Flows tab in the right pane, filtered to display only flows and 
folders containing flows.

 3 In the Test Plan Tree, select the flow that you want to add to the business 
process test and click the Add to Test button. 

 4 To add additional flows to the test, repeat step 3 for each additional flow.

After you add flows to a test, you can manage the flows within the test in 
the same way as you would for business components within a test. For more 
information on managing business components in a business process test, 
see the HP Business Process Testing User’s Guide.

Tip: Flows can also be added directly to test sets in the Test Lab module.
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Working with Flow Parameters

This chapter describes how to use flow input and output parameters to 
increase the flexibility of your flows and tests.

This chapter includes:

 ➤  About Working with Flow Parameters on page 31

 ➤  Understanding Flow Input Parameters on page 32

 ➤  Defining Flow Output Parameters on page 41

 ➤  Understanding Table Parameters on page 43

About Working with Flow Parameters

You can use flow parameters to increase the flexibility of your flows and 
tests. Flow parameters enable you to perform the same operations on the 
application you are testing with multiple sets of data.

There are two types of flow parameters: flow input parameters and flow 
output parameters.

➤ Flow input parameters enable you to define data used by a flow that is 
provided to the flow from an external source. You can generate flow input 
parameters automatically, based on existing component input parameters. 
You can also define flow input parameters manually by specifying a new 
flow input parameter as the value for a component input parameter. After 
you define a flow input parameter, you can assign it a default value.
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➤ Flow output parameters enable you to define data that is retrieved and 
stored by a flow and can be used in subsequent components or flows in a 
business process test.

Note: In addition to flow parameters, you can also define component 
parameters for business components within a flow or test. For more 
information on component parameters, refer to the HP Business Process 
Testing User’s Guide.

For example, suppose you create three flows corresponding to different 
stages in processing a customer order:

➤ ReceiveOrder. Receives a customer order and generates a unique order 
number when the customer authorizes the order.

➤ SendOrder. Sends the customer the goods the customer ordered.

➤ BillOrder. Sends the customer a bill for the goods.

In this example, you want to define a business process test to test the entire 
order processing workflow from receiving the order to billing it. You could 
therefore define an output parameter from the flow ReceiveOrder called 
OrderNumber, which stores the value of the order number generated when 
the order is placed. You could then use this value as an input parameter for 
the subsequent flows in the business process test.

Understanding Flow Input Parameters

A flow input parameter is an input parameter that can receive a fixed value, 
use a value returned by a flow output parameter or a component output 
parameter from the same flow, or use a parameter value that is supplied 
when the flow runs in a business process test in the Test Lab module.
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A flow input parameter must be assigned as an input parameter of a business 
component that is included in the flow. By default, the value for the flow 
parameter is then used as the value of the component input parameter. For 
more information on component input parameters, see the HP Business 
Process Testing User’s Guide.

You can generate flow input parameters based on existing input parameters 
for a component, or define a new flow input parameter by specifying the 
new parameter as the value for a component input parameter.

This section includes the following topics:

➤ Generating Flow Input Parameters

➤ Defining Flow Input Parameters

Generating Flow Input Parameters
You can generate flow input parameters based on existing input parameters 
for a component within the flow. When the component runs, these 
component input parameters take the values assigned to the corresponding 
flow input parameters.

There are several ways to generate flow input parameters. For example, you 
can:

➤ specify whether to use the same or unique flow parameters for each iteration

➤ configure the naming convention for your flow parameters

➤ generate flow parameters for all component parameters

➤ specify the cells in the Component Iterations or Group Iterations dialog box 
for which you want to generate flow parameters
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To generate flow input parameters:

 1 In the Test Plan Tree, select the flow for which you want to generate flow 
input parameters. Click the Test Script tab.

 2 In the Test Script tab, right-click the component whose component input 
parameters you want to use as a basis for generating flow input parameters 
and select Iterations, or click on the parameter name. The Component 
Iterations dialog box opens.

Most of the functionality available in the Component Iterations dialog box 
for flows is the same as that available for regular components. For more 
information on this functionality, see the HP Business Process Testing User’s 
Guide.

Tip: You can also generate flow input parameters automatically from the 
Group Iterations dialog box, based on input parameters for components 
within component groups. You generate flow input parameters from the 
Group Iterations dialog box as you would from the Component Iterations 
dialog box. For more information on component groups, see the HP Business 
Process Testing User’s Guide.
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 3 Click the Flow Parameters button. Define the criteria for creating and 
naming flow parameters. For more information, see “Understanding the 
Define Flow Parameters Dialog Box.” on page 35.

 4 Click OK. The Define Flow Parameters dialog box closes and flow input 
parameters are generated for the flow, based on the criteria you selected.

Understanding the Define Flow Parameters Dialog Box.
The Define Flow Parameters dialog box defines the way flow parameters are 
created and named.
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The Define Flow Input Parameters dialog box contains the following 
options:

The Advanced Options link expands the dialog box to display the following 
options:

Option Description

Define the criteria for 
creating flow parameters

➤ Use the same flow parameter for each 
iteration. Clears the flow parameter values 
between iterations so that the same parameter 
names are used for every iteration, but the 
values are not passed from one iteration to the 
next.

➤ Use a different flow parameter for each 
iteration. Automatically creates a new flow 
parameter for each iteration. The parameter 
values are saved with each iteration run.

Include component name 
before flow parameter name

Adds the component name as a prefix preceding 
the generated flow parameter name.

Example Provides an example of the flow parameter name 
based on the selected criteria.

Option Cells for which flow parameters are generated

Create flow parameters for Empty cells only. Creates flow parameters only 
for cells that do not contain any value (default).

Empty cells and cells with default values. Creates 
flow parameters for all cells that either do not 
contain a value or contain the default value 
defined in the component parameter.

All cells. Creates flow parameters for all cells in 
the Component Iterations or Group Iterations 
dialog box.
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Defining Flow Input Parameters
You can define flow input parameters manually from the Component 
Iterations dialog box, by specifying the new parameter as the value for a 
component input parameter.

Most of the functionality available in the Component Iterations dialog box 
for flows is the same as that available for regular components. For more 
information on this functionality, see the HP Business Process Testing User’s 
Guide.

Tip: You can also define flow input parameters from the Group Iterations 
dialog box. You define flow input parameters from the Group Iterations 
dialog box as you would from the Component Iterations dialog box. For 
more information on component groups, see the HP Business Process Testing 
User’s Guide.

To define a flow input parameter:

 1 In the Test Plan Tree, select the flow for which you want to add a flow input 
parameter. Click the Test Script tab.
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 2 In the Test Script tab, right-click a business component in the flow and 
choose Iterations, or click on the parameter name. The Component 
Iterations dialog box opens.

 3 If you want to create a flow input parameter to assign to a string or date type 
component input parameter, proceed to step 4.

If you want to create a flow input parameter to assign to a number, boolean, 
or password type component input parameter, click the relevant cell, click 
the down arrow, and select <New Flow Parameter>. Type the name of the 
flow input parameter you want to create. Proceed to step 9.

 4 If you want to create a flow input parameter to assign to a string or date type 
component input parameter, click the relevant cell and click the browse 
button. The Set String Value or Set Calendar Value dialog box opens.
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 5 Select Flow parameter. A list of existing flow input parameters is displayed.

 6 Click the Add Flow Parameter button. The New Flow Parameter dialog box 
opens.

 7 In the Name box, type a name for the flow input parameter you want to 
create and click OK. The New Flow Parameter dialog box closes.

 8 Click OK. The Set String Value or Set Calendar Value dialog box closes.

 9 Click OK. The Component Iterations dialog box closes.
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Defining Default Flow Input Parameter Values
You can define default values for flow input parameters. When you run a 
test containing a flow, and no value is supplied to the flow input parameter 
from some other source, the default value is used.

To define a default flow input parameter value:

 1 In the Test Plan Tree, select a flow that has at least one flow input parameter.

 2 In the Test Script tab, click the Flow Input Parameters button. The Flow 
Input Parameters dialog box opens.

 3 Select the parameter for which you want to define a default value and click 
the Value column.

 4 Type or select the default value you want to use for the parameter. This value 
must be consistent with the parameter type displayed in the Value Type 
column.

 5 In the Description box, you can type a description of the parameter.

 6 Click OK. The Flow Input Parameters dialog box closes.
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Defining Flow Output Parameters

A flow output parameter is a parameter whose value can be returned from a 
flow and used as an input parameter value in a subsequent component 
outside of the current flow in a business process test, or as an input flow 
parameter.

A flow output parameter must be an output parameter of a business 
component that is included in the flow. For more information on 
component output parameters, see the HP Business Process Testing User’s 
Guide.

When you create a flow output parameter for a specific component output 
parameter, it is automatically renamed to match the component and flow 
parameter naming convention. If required, you can change the flow output 
parameter name to suit your needs.

To define a flow output parameter:

 1 In the Test Plan Tree, select the flow for which you want to define a flow 
output parameter.
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 2 In the Test Script tab, click the Flow Output Parameters button. The Flow 
Output Parameters dialog box opens.

The Available Component Output Parameters list displays the output 
parameters of the components in the flow that are not already defined as 
flow output parameters. The components are listed using the following 
naming convention: [<ComponentName>:<Iteration>] <ParameterName>

The Flow Output Parameters list displays the output parameters of 
components in the flow that are already defined as flow output parameters.

 3 In the Available Component Output Parameters list, select the component 
output parameter that you want to define as a flow output parameter and 
click the Add button.

Tip: You can click the Add All button to define all component output 
parameters in the flow as flow output parameters.
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 4 To rename a flow output parameter, select the parameter in the Flow Output 
Parameters list, and click the Rename button. Type the new name and press 
ENTER. Note that renaming a flow output parameter does not rename the 
corresponding component output parameter.

Consider the following when renaming a flow output parameter:

➤ The parameter name must be unique within the flow.

➤ The parameter name must begin with a letter. If the first character of the 
component name is not a letter, the prefix comp_ is added.

➤ The parameter name must not contain non-English characters nor any of 
the following characters: ! @ # $ % ^ & * ( ) + = \ { } | ; ' : " , . / < > ? ~ ` [ ] –
Any invalid character is automatically replaced by an underscore (_).

 5 To remove a defined flow output parameter, in the Flow Output Parameters 
list, select the flow output parameter and click the Remove button.

Tip: You can click the Remove All button to remove all defined flow 
parameters.

 6 Click OK. The Flow Output Parameters dialog box closes.

Understanding Table Parameters

When you enter data to a table in your SAP application while learning a 
flow automatically, Business Process Testing for SAP Applications creates a 
table parameter. 

Note: To create table parameters during the learn flow process, you must 
enable QuickTest to create table parameters. In QuickTest select Tools > 
Options and click the SAP tab. Under SAP GUI for Windows > Record 
settings ensure that the Auto-parameterize table and grid controls check 
box is selected.
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A table parameter is a component input parameter that enables you to use a 
single parameter to set multiple table cells for a table in your SAP 
application instead of using separate parameters for each table cell. 

Note: Empty columns are ignored when comparing table parameters. For 
example, suppose table parameter Alpha has columns A, B, and C, with 
content in all three columns, and table parameter Beta has columns A, B, C, 
and D but column C is empty. If the content of the three columns with 
content in table parameter Beta (A, B, and D) matches that of the three 
columns in table parameter Alpha, the two table parameters are seen as 
equal.

A table parameter can be created only when learning flows automatically. 
You can export the table parameter definition to a .csv (comma separated 
values) file or import data from an existing .csv file. The table parameter 
definition includes the table structure and default values.  
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You can access the Set Table Value dialog box:

➤ On the component level. When setting default values of parameters, a Table 
Parameter is displayed as [Table Data]. Click this link to open the Set Table 
Value dialog box.

➤ On the flow level. When setting parameter values for component iterations, 
a Table Parameter is displayed as [Table Data]. Click this link to open the Set 
Table Value dialog box.

➤ On the test level. When setting parameter values for flow iterations, a Table 
Parameter is displayed as [Table Data]. Click this link to open the Set Table 
Value dialog box.

➤ On the test set level. When setting parameter values for test iterations, a 
Table Parameter is displayed as [Table Data]. Click this link to open the Set 
Table Value dialog box.

➤ In the Run Condition dialog box. When specifying criteria for run 
conditions, a Table Parameter is displayed as [Table Data] in the Value edit 
box. Click this link to open the Set Table Value dialog box. 

The Set Table Value dialog box contains the following options:

Option Description

Fixed value Available only when accessing the Set Table Value 
dialog box via a flow in the Test Plan module. 
Enables you to enter fixed values in the individual 
cells of the table parameter.

Flow parameter Available only when accessing the Set Table Value 
dialog box via a flow in the Test Plan module. 
Enables you to define the table parameter as a flow 
parameter.

Run-time parameter Available only when accessing the Set Table Value 
dialog box via a business process test in the Test 
Plan module. Enables you to define the table 
parameter as a run-time parameter.
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Tip: Use the export option to generate the .csv file and then edit or add data 
as necessary. This ensures the proper format of the .csv file.

Add Column Adds a column to the table parameter grid. The 
column is added to the right of the column in 
which the cursor is currently located. If the cursor is 
not in any column, the column is added at the end.

Add Row Adds a row to the table parameter grid. The row is 
added below the row in which the cursor is 
currently located. If the cursor is not in any row, the 
row is added at the end.

Table cell Enables editing of the default value for a table cell. 
Select the cell and enter the default value.

Column headers Enables renaming of columns. Click on the header 
to rename the column. Column names must match 
the column names in the SAP application. You can 
also use the SAP index of a column with the # sign 
to name a column. For example, #3.

Delete Column Deletes the selected column from the table 
parameter grid. 

Delete Row Deletes the selected row from the table parameter 
grid.

Export Exports the table parameter definition to a .csv 
(comma separated values) file. 

Import Imports a table parameter definition from a .csv file. 
Ensure that the file is in the proper format.

Option Description
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Learning Flows

This chapter describes how to learn flows automatically by navigating your 
SAP application.

This chapter includes:

 ➤  About Learning Flows on page 48

 ➤  How Business Process Testing for SAP Applications Creates Components 
on page 49

 ➤  Learning Flows Automatically on page 51

 ➤  Understanding the Learn Flow Toolbar on page 56

 ➤  Adding Checkpoints to Flows on page 57

 ➤  Adding Output Values to Flows on page 58

 ➤  Understanding the Learn Flow Summary Dialog Box on page 59
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About Learning Flows

If you are testing an SAP application and you have QuickTest Professional 
installed on your machine, Business Process Testing for SAP Applications 
enables you to learn a flow automatically, as you navigate through your SAP 
application. You first create an empty flow or select an existing flow, and 
then start the learn flow process. You then perform the operations in your 
application that you want Business Process Testing for SAP Applications to 
learn.

After you finish learning the flow, the extension breaks down the flow 
learned into a sequence of automated QuickTest keyword-driven business 
components, each representing a screen or tab in your SAP application. 
Parameters are automatically created for the steps in the components, based 
on user interface controls in the SAP application. You can use these learned 
flows as the basis for creating business process tests to test your SAP 
application. For more details on how Business Process Testing for SAP 
Applications breaks up a learned flow into components and creates 
parameters, see “How Business Process Testing for SAP Applications Creates 
Components” on page 49.

If you are working with the Application Model and it contains application 
entities related to the created components, these entities are automatically 
associated with the related components. For more information on working 
with the Application Model module, see Chapter 7, “Working with 
Application Model Entities in Quality Center.”

Note: During the Learn Flow process resources are created which are stored 
in the BPT Resources folder. For the Business Process Test to perform 
properly, this folder and any of its sub folders should not be renamed or 
deleted.

You learn flows from the Test Plan module. For more information on 
learning flows, see “Learning Flows Automatically” on page 51.
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How Business Process Testing for SAP Applications Creates 
Components

When Business Process Testing for SAP Applications learns a flow, it creates a 
new business component for each screen or tab through which you navigate 
in your SAP application. Each screen or tab within a particular transaction is 
represented as a separate business component. A separate component is 
created for a particular screen or tab for each transaction in which it is used.

The name of a created component is of the form <Transaction 
code>-<Screen name>. If the transaction code or screen name contains 
spaces or characters that are not valid in the names of business components, 
these characters are replaced by underscores (_). For example, if a 
component corresponds to the screen Create Sales Order: Initial Screen in 
the VA01 transaction, the component is named 
VA01-Create_Sales_Order_Intial_Screen.

If you navigate from one screen to a different screen or tab, and then return 
to the original screen, a new component is created with the same name as 
the component corresponding to the original screen, with a numerical 
suffix appended to differentiate between the components. For example, 
suppose the component corresponding to a screen is named VA01_Test. If 
you return to the screen, a new component is created named VA01_Test_01.

For each user operation within a screen that requires data specified by the 
user, a component input parameter is created for that step. The component 
input parameters that are created during the Learn Flow process are 
automatically set as flow parameters. The value input during the learn flow 
process used as the default parameter value. For example, a parameter would 
be created for a value entered in a text field. 

If you add data to a table in your SAP application, a component table 
parameter is created. Table parameters enable you to use one parameter for 
an entire table, rather than using separate parameters for each table cell. For 
more information on working with table parameters, see “Understanding 
Table Parameters” on page 43.
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Notes: 

➤ During the learn flow process the table parameter saves the data only 
after you move the focus out of the table. If the table data is the last step 
in a learn process, ensure that you move the focus out of the table before 
stopping the learn.

➤ To create table parameters during the learn flow process, you must enable 
QuickTest to create table parameters. In QuickTest select Tools > Options 
> SAP tab. Under SAP GUI for Windows > Record settings ensure that the 
Auto-parameterize table and grid controls check box is checked. For 
more information, see “Understanding Table Parameters” on page 43.

If a screen contains a tab strip, one component is created for the common 
area on the screen, and a separate component is created for each tab opened. 
The status bar is included in each component created for the screen. For 
example, consider the screen below:
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When you learn a flow containing this screen, operations performed on the 
upper area of the screen containing the menus, toolbars, and common fields 
(such as Standard Order and Net value) comprise a single business 
component. Operations performed in each of the Sales, Item overview, Item 
detail, Ordering party, Procurement, Shipping, and Reason for rejection 
tabs result in the creation of separate business components.

Learning Flows Automatically

You can learn a flow automatically from the Test Plan module. You can 
create a new flow or insert components created during the learn flow 
process into an existing flow.

Notes: 

➤ To learn a flow, a user must belong to a user group that has permissions 
for the Modify Test task. For more information on configuring user group 
permission settings, see the HP Quality Center Administrator’s Guide.

➤ Only the SAP GUI client is supported by Business Process Testing for SAP 
Applications.
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To learn a flow:

 1 Open and log in to the SAP application for which you want to learn the 
flow, and navigate to the point at which you want to start learning the flow.

Note: 

➤ You must log in to your application before you start to learn the flow. 
Business Process Testing for SAP Applications is not able to learn the 
login procedure.

➤ If you want to insert learned components into an existing flow, you can 
use the option described in step 5 to run the initial components
to navigate to the correct location in your application.

 2 In the Test Plan module, create a new flow or select an existing flow. For 
more information on creating flows, see “Creating Flows” on page 22.

 3 Click the Test Script tab.

 4 If there are already components in the flow and you want to insert the new 
components between existing components, select the component after 
which you want to insert the new components.

For example, suppose your flow contains the components Comp_1, Comp_2, 
and Comp_3. If you want to insert the new components between Comp_2 
and Comp_3, select Comp_2.

Note: To insert the new components at the beginning of the flow (before 
existing components), you must first insert the new components to a 
different location, and then change the order of the components in the flow 
manually after the learn process is finished.

 5 In the Test Script tab toolbar, click the Learn Flow button. 
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If there are already business components in the flow, the Learn Flow dialog 
box opens.

Select one of the following options for handling the existing components, 
and click OK. The Learn Flow dialog box closes.

A message box reminds you that you must open your SAP application. Click 
Learn Flow to continue.

Option Description

Remove existing 
Components

Removes all the existing business components from 
the flow and learns the components in the emptied 
flow.

Insert new components. Learns the flow and inserts the resulting 
components after the selected existing component.

Run and insert Runs the existing components in the flow until the 
selected component, then learns the flow, and 
inserts the resulting components after the selected 
existing component.
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 6 The Learn Flow toolbar opens.

In the Learn Flow toolbar, click the Learn Flow button. The button changes 
to a Stop Learn button.

 7 In your SAP application, perform the operations that you want to learn. 
While Business Process Testing for SAP Applications is learning the flow, you 
can control the learn flow process using the Learn Flow toolbar. For more 
information, see “Understanding the Learn Flow Toolbar” on page 56.

 8 When you finish performing the operations that you want to learn, click the 
Stop Learn button in the Learn Flow toolbar. The Learn Flow Summary 
dialog box opens.

 9 You can use the Learn Flow Summary dialog box to view details of the 
learned steps. For more information, see “Understanding the Learn Flow 
Summary Dialog Box” on page 59.

 10 By default, the created components are added to the Business Components 
Tree in a folder with a path parallel to the path of the flow in the Test Plan 
Tree. For example, if the flow MyFlow is located in the folder 
Subject\MyFlows in the Test Plan Tree, the learned business components are, 
by default, created in the folder Components\MyFlows\MyFlow.
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To change the default location, click the Expand button to expand the 
Advanced Details area and click the browse button. The Select Business 
Component Folder dialog box opens.

Select the folder in which to create the business components.

You can create a new folder in the Business Components Tree. To create a 
new folder, select the folder under which you want to create the new folder 
and click the Create New Folder button. In the Create New Folder dialog 
box that opens, type a name for the new folder. Click OK.

Click OK. The Select Business Component Folder dialog box closes.

 11 Click Save. The Learn Flow Summary dialog box closes. The components 
created as a result of the learn flow process are added to the Business 
Components module, and these components are added to the flow. It may 
take some time to save the created components.
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Note: Creation of business components for a learned flow may take some 
time.

Understanding the Learn Flow Toolbar

The following table describes the features of the Learn Flow toolbar, which 
enables you to control the learn flow process. For more information on 
learning flows, see “Learning Flows Automatically” on page 51.

Button Description

(Available only when Business Process Testing for 
SAP Applications is not learning a flow.) Starts 
learning a flow.

(Available only when Business Process Testing for 
SAP Applications is learning a flow.) Stops learning a 
flow.

(Available only when Business Process Testing for 
SAP Applications is learning a flow.) Pauses learning 
a flow. When the learn flow process is paused, any 
actions you perform on your SAP application are 
not learned. To resume learning actions, click the 
Resume button.

(Available only when the learn flow process is 
paused) Resumes learning after a pause.

Inserts a checkpoint into the automated 
component. A checkpoint is a verification point 
that compares a current value for a specified 
property with the expected value for that property. 
This enables you to identify whether your SAP 
application is functioning correctly. For more 
information, see the “Adding Checkpoints to 
Flows” on page 57.
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Adding Checkpoints to Flows

You can add object property checkpoints to a component during the Learn 
Flow process. Object property checkpoints enable you to check object 
property values during a test run to determine if they match expected 
values. The test results provide information about which object property 
checkpoints failed during a test run, and why.

To insert a checkpoint during the Learn Flow process:

 1 During the Learn Flow process, perform the operations you want to learn up 
to the point that you want to insert a checkpoint. Click the Add Checkpoint 
button on the Learn Flow toolbar. The cursor changes to a pointing hand 
and the Learn Flow toolbar is hidden.

 2 Point to the object in your SAP application for which you want to create an 
object property checkpoint. The Checkpoint Properties dialog box opens. 

Enables you to add an output value to the 
automated component. An output value is a step in 
which one or more values are captured at a specific 
point in your test and stored for later use. For more 
information, see “Adding Output Values to Flows” 
on page 58.

Cancels the current learn flow process. If you cancel 
the learn flow process, all flows learned during that 
session are not saved.

Button Description
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 3 By default, all the properties in the dialog are selected for verification.  Clear 
the check box of any values you do not want to check and click OK. The 
object property checkpoint is added to the component.

 4 Continue performing operations in your SAP application to continue 
learning the flow. 

Adding Output Values to Flows

You can add an object property output value step to a component during 
the Learn Flow process. Object property output value steps allow you to 
capture and store values during your test. These values can later be used as 
input at a different point in the run session.

To insert an object property output value during the Learn Flow process:

 1 During the Learn Flow process, perform the operations you want to learn up 
to the point that you want to insert a checkpoint. Click the Add Output 
Value button on the Learn Flow toolbar. The cursor changes to a pointing 
hand and the Learn Flow toolbar is hidden.

 2 Point to the object on the screen for which you want to create an output 
value. The Output Value Properties dialog box opens. 

 3 By default, none of the properties are selected for the Output. Select those 
properties whose values you want to output and click OK. The object 
property output value step is added to the component.

 4 Continue performing operations in your SAP application to continue 
learning the flow. 
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Understanding the Learn Flow Summary Dialog Box

The Learn Flow Summary dialog box displays information about the steps 
performed during the learn process and the components created as a result. 
For more information on learning flows, see “Learning Flows 
Automatically” on page 51.

Note: When it opens, the Learn Flow Summary dialog box is displayed with 
the Advanced Details section collapsed. Click the double arrow to the right 
of Advanced Details to expand and display the full dialog box.
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The Learn Flow Summary dialog contains the following elements:

Element Description

Flow Details pane The top section of the Learn Flow Summary dialog 
box displays details about the flow. 

The flow details pane contains the following 
information:

➤ Flow Name. The name of the flow.

➤ Flow Designer. The Quality Center user name of 
the user who designed the flow.

➤ Creation Date. The date and time on which the 
flow was created.

Advanced Details Area Displays additional information about the learned 
flow. Click the arrows to expand and collapse this 
area. 

Component Path Displays the location where the learned 
components will be stored. You can change the 
path by clicking in the path and browsing to the 
new location. 

Learned Flow Displays the business components learned as part of 
the flow. You can select a component to display (in 
the steps tab) a breakdown of the steps in that 
component, and a screenshot of the application at 
the end of the component’s execution (in the 
Screenshot tab).

Steps tab Displays a description of the steps performed in the 
currently selected business component.

Screenshot tab Displays a screenshot of your application at the 
selected step in the flow.

Save Saves the components to the Business Components 
module and adds them to the flow.

Resume Resumes learning the flow without saving the 
learned components.

Cancel Cancels learning the flow. All the learned 
components are deleted.
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Defining Run Conditions

This chapter describes how to define and work with run conditions for your 
flows.

This chapter includes:

 ➤  About Defining Run Conditions on page 61

 ➤  Adding Run Conditions on page 64

 ➤  Managing Run Conditions on page 67

 ➤  Running Tests with Run Conditions on page 68

About Defining Run Conditions

You can use run conditions to insert condition statements into your flows. A 
run condition checks the current value of a given parameter before running 
a component in a flow. It then determines whether to run the component, 
skip the component run, or end a run session completely, based on the 
parameter’s value and the run condition’s definition.

When you run business process tests containing flows with run conditions, 
the test run results displays the results of run conditions in the test, and 
which components were not run because a run condition was not met.
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Run Condition Example
Suppose you want to test a shopping application that allows all customers to 
purchase items whose total value is less than USD $100, and allows only 
those customers with an acceptable credit rating to purchase items whose 
total value is equal to or greater than USD $100. You can apply run 
conditions to your components to determine whether to continue or end 
the component run or the entire business process test run based on the total 
value of the purchase and the customer's credit rating.

For this scenario, you might create three components and insert them in a 
PurchaseItems flow. (The end of this section includes a flowchart illustrating 
this example scenario.)

The first component, ConfirmOrder, confirms the order and contains an 
output parameter, TotalPrice, that stores the total purchase price. There is no 
need to add a run condition to this component.

The second component, CheckCreditRating, checks the customer's credit 
rating. This component receives as an input parameter the value of the 
TotalPrice output parameter from the previous component. This component 
also generates a Boolean output parameter, PurchaseApproval, whose value 
is set to True if the value of the TotalPrice parameter is less than 100, or if the 
value of the TotalPrice parameter is greater than or equal to 100 and the 
credit rating has an acceptable value. 

Since everyone can make purchases under $100, there is no need to run the 
CheckCreditRating component in these cases. You can create a run condition 
for this component that checks the value of the TotalPrice parameter and 
skips to the next component, PayForPurchases, if the value of the TotalPrice 
parameter is less than 100, and continues to run the CheckCreditRating 
component if the value of the TotalPrice parameter is equal to or greater 
than 100.

The third component, PayForPurchases, has an input parameter, 
PurchaseApproval, that receives the output value of the CheckCreditRating 
component. If the CheckCreditRating component was skipped (because the 
value was less than 100), the default value, True, is automatically applied to 
this output value. If the CheckCreditRating component did run, then the 
value of the PurchaseApproval parameter is set to True or False depending on 
the customer's credit rating.
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You can create a run condition for this component that checks the value of 
the PurchaseApproval parameter. If the value is set to True, it continues the 
component run and accepts the payment details. Otherwise, the component 
run session ends (and the run fails).

The following flowchart illustrates the above example.
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Adding Run Conditions

This section describes how to add run conditions. When you add a run 
condition, the condition is displayed in the Run Condition column of the 
Test Flow pane in the Test Script tab. For guidelines for working with run 
conditions, see “Guidelines for Working with Run Conditions” on page 67.

To add a run condition:

 1 In the Test Script tab for a flow, do one of the following:

➤ Select the component for which you want to add the run condition and 
click the Add Run Condition button.

➤ Right-click the component for which you want to add the run condition 
and select Run condition.

The Run Condition dialog box opens.
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 2 In the Parameter Type box, select a parameter type. The following types are 
available:

➤ Input Parameter. Available only if one or more input parameters are 
defined for this component.

➤ Output Parameter. Available only if one or more output parameters are 
defined for one or more of the previous components in the flow.

➤ Flow Parameter. Available only if one or more flow input parameters are 
defined. For more information on flow input parameters, see 
“Understanding Flow Input Parameters” on page 32.

 3 In the Parameter Name box, select a parameter from the list of available 
parameters.

 4 In the Condition box, select a condition. The following conditions are 
available:

➤ Equal to

➤ Not equal to

➤ Less than (not available for table parameters)

➤ Less than or equal to (not available for table parameters)

➤ Greater than (not available for table parameters)

➤ Greater than or equal to (not available for table parameters)

Prior to a component run, the condition and value are checked. If the 
condition and value you select are met, the component run continues. If the 
condition and value you select are not met, then the component does not 
run, and the run session proceeds according to your selection in the 
Otherwise box.

 5 In the Value box, type a valid value for the condition. 
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Note: If the parameter selected in the Parameter Name box is a table 
parameter, [Table Data] is displayed in the Value box. Click this link to open 
the Set Table Value dialog box and set the cell values required for your 
condition. For more information, see “Understanding Table Parameters” on 
page 43. 

 6 In the Otherwise box, specify what to do if the condition is not met. The 
following options are available:

➤ Skip to next component and continue. If the condition is not met, the 
component for which the run condition is set does not run, and the test 
run continues with the next component in the flow.

➤ End component run and fail. If the condition is not met, does not run the 
component for which the run condition is set, but instead sets the status 
of the component run as Failed. The flow either continues to the next 
component or ends, depending on the failure condition set for the 
component. For more information on defining failure conditions for 
components, see the HP Business Process Testing User’s Guide.

Tip: Your selection in the Otherwise box applies only if the run condition is 
not met. To specify whether to continue or end the entire business process 
test run if a component run fails, set the failure condition for the 
component. You do this in the Test Script tab of the Test Plan module. For 
more information, see the HP Business Process Testing User’s Guide.

 7 Click OK. The Run Condition dialog box closes and the run condition is 
added to the flow.
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Guidelines for Working with Run Conditions

➤ You can define only one run condition per business component.

➤ To set run conditions for a component the component or flow input or 
output parameter must contain at least one input parameter.

➤ In some cases, it may be preferable to define different flows, rather than 
using a large number of run conditions within a particular flow. 

➤ If you set run conditions, and later add or remove a component or change 
the component order within a flow, the parameters may no longer be 
relevant and the run condition may not work. For example, if Component B 
uses an output parameter from Component A, and you change the order of 
the components so that Component B precedes Component A, then 
Component B cannot receive the output parameter from Component A and 
the run fails. 

Managing Run Conditions

After you create a run condition, you can modify its settings. You can also 
remove a run condition from a flow. This section includes the following 
topics:

➤ Modifying Run Conditions

➤ Removing Run Conditions

Modifying Run Conditions
This section describes how to modify run conditions.

To modify a run condition:

 1 In the Test Script tab for a flow, right-click the component and select Run 
Condition. The Run Condition dialog box opens.

 2 In the Run Condition dialog box, modify the criteria and alternative 
behavior as needed. For more information on the available options, see 
“Adding Run Conditions” on page 64.

 3 Click OK. The run condition is modified. 
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Removing Run Conditions
This section describes how to remove run conditions.

To remove a run condition:

 1 In the Test Flow pane of the Test Script tab, do one of the following:

➤ Select the component and click the Remove Run Condition button.

➤ Right-click the component and select Remove run condition.

 2 Click Yes in the confirmation box. The run condition is removed from the 
flow. 

Running Tests with Run Conditions

You run a business process test containing flows with run conditions as you 
would for a regular business process test. For more information on running 
business process tests, refer to the HP Business Process Testing User’s Guide.

As with regular business process tests, you can view test results in the Last 
Run Result pane in the Test Lab module.

➤ If you select Skip to next component and continue for a run condition, and 
the run condition you specify is not met, the test results list the run status 
for the component with the run condition as Ignored. The component will 
not be displayed in the run results.

➤ If you select End component run and fail for a run condition, and the run 
condition you specify is not met, the test results list the run status for the 
component with the run condition as Failed.

If a run condition was not met, the test results also provide details about the 
condition that was not met to help you understand why the component run 
failed or did not run.
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Detecting and Resolving Changes

This chapter describes how to use the Business Process Testing for SAP 
Applications to automatically detect changes in your SAP application, and 
update the relevant business process tests accordingly.

This chapter includes:

 ➤  Detecting Changes on page 70

 ➤  Viewing Change Detection Results on page 76

 ➤  Resolving Changes on page 83

 ➤  Changes and Resolutions on page 85

About Detecting and Resolving Changes

You can run business process tests and flows in change detection mode. 
When a test or flow is run in change detection mode, Business Process 
Testing for SAP Applications checks for changes made in the SAP application 
since the test or flow was last updated. When the test or flow run is finished, 
you can view a report detailing these changes. This provides an indication of 
which modifications you should make to your test or flow to make sure that 
it is up-to-date.

For each change that is detected, Business Process Testing for SAP 
Applications offers possible resolutions. These enable you to make updates 
to your test or flow automatically. You can also choose to resolve a change 
manually, or to open a defect for handling a change. For a list of supported 
changes and resolutions, see “Changes and Resolutions” on page 85.
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For example, suppose you are testing a screen for inputting contact 
information for new customers. The screen contains the fields Name, 
Address, and Phone Number. You create a test that verifies that information 
entered in these fields is correctly added to your customer database. Suppose 
you now add an E-mail Address field to the screen. If you run your test in 
regular mode, the test may pass and you may not notice that there is an 
additional field that should be tested. However, if you run the test in change 
detection mode, Business Process Testing for SAP Applications notices that 
the field was added to the screen and suggests adding a step to the test 
corresponding to the new field. You can then run an updated version of the 
test that includes verification of the additional field.

Note: Tests and flows that are run in Change Detection mode run only one 
iteration of any component, flow, or test even if multiple iterations are 
defined.

Detecting Changes

You can detect changes to an individual flow, test, or test set.

Notes:

➤ To detect changes, a user must belong to a user group that has 
permissions for the Run task, and permissions to modify tests and 
business components. For more information on configuring user group 
permission settings, see the HP Quality Center Administrator’s Guide.

➤ Only business components created using the Learn Flow option can run 
in change detection mode. Other components always run in regular 
mode. For more information about the learn Flow option, see Chapter 4, 
“Learning Flows.”
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Detecting Changes for a Flow
You can detect changes for an individual flow from within the Test Plan and 
Test Lab modules.

To detect changes to a flow from within the Test Plan module:

 1 In the Test Plan module, right-click the flow for which you want to detect 
changes and select Detect Changes. The Select Test Set dialog box opens.

Notes: 

➤ The Test list is displayed only if the flow is included in more than one 
test set in the Test Lab module.

➤ If the flow is included only once in one test set and it is included directly 
(not from within a test), the Select Test Set dialog box does not open.

➤ If the flow is not included in any test set, when you select Detect 
Changes it is automatically added directly to the default test set in the 
Unattached folder. The Select Test Set dialog box does not open and the 
Automatic Runner dialog box opens instead.
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 2 Select from the Test, Test Set, and Test Instance lists to define which 
instance of the flow you want to run. For more information, see 
“Understanding the Select Test Set Dialog Box” on page 82. Click OK. The 
Automatic Runner dialog box opens. 

 3 Select the flow you want to run and ensure that the Detect Changes check 
box is selected. Click Run. For more information on the Automatic Runner 
dialog box and running tests automatically, see the HP Quality Center User’s 
Guide.
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To detect changes for a flow from the Test Lab module:

 1 In the Test Lab module select the test set that includes the flow for which 
you want to detect changes. Click the Run button. The Automatic Runner 
dialog box opens. 

 2 Select the Detect Changes check box. Click Run. For more information on 
the Automatic Runner dialog box and running tests automatically, see the 
HP Quality Center User’s Guide.

Detecting Changes for a Business Process Test
You can detect changes for a business process test from the Test Plan and 
Test Lab modules. 
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To detect changes for a business process test from the Test Plan module:

 1 In the Test Plan module, right-click the business process test for which you 
want to detect changes and select Detect Changes. The Select Test Set dialog 
box opens.

Note: If there is only one instance of the business process test, the Select Test 
Set dialog box does not open.

 2 Select from the Test Set and Test Instance lists to define which instance of 
the test you want to run. For more information, see “Understanding the 
Select Test Set Dialog Box” on page 82. Click OK. The Automatic Runner 
dialog box opens. 
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 3 Select the business process test you want to run and ensure that the Detect 
Changes check box is selected. Click Run. For more information on the 
Automatic Runner dialog box and running tests automatically, see the 
HP Quality Center User’s Guide.

To detect changes for a business process test from the Test Lab module:

 1 In the Test Lab module, select the test set that includes the business process 
test for which you want to detect changes. Click the Run button. The 
Automatic Runner dialog box opens. 

 2 Select the business process test you want to run and select the Detect 
Changes check box. Click Run. For more information on the Automatic 
Runner dialog box and running tests automatically, see the 
HP Quality Center User’s Guide.
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Detecting Changes for a Test Set
You detect changes for a test set in the Test Lab module.

To detect changes for a test set:

 1 In the Test Lab module select the test set for which you want to detect 
changes. Click the Run Test Set button. The Automatic Runner dialog box 
opens. 

 2 Ensure that the Detect Changes check box is selected and click Run All. For 
more information on the Automatic Runner dialog box and running tests 
automatically, see the HP Quality Center User’s Guide.

Viewing Change Detection Results

This section describes how to view results of a test or flow run in change 
detection mode. The section includes the following topics:

➤ Viewing Change Detection Results

➤ Understanding the Change Detection Report
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Viewing Change Detection Results
You view the results of a test or flow run in change detection mode in the 
Change Detection Report dialog box. You can open the Change Detection 
Report dialog box from the Test Plan module or the Test Lab module.

Note: If a test or flow was run in Change Detection mode, but no changes 
were detected, Update Changes will be disabled. You can view the Change 
Detection Report dialog box from the Test Lab module only.

To open the Change Detection Report dialog box from the Test Plan 
module:

 1 In the Test Plan Tree, right-click the test or flow and select Update Changes. 
The Select Test Set dialog box opens.

Note: If the flow or test has changes detected for only one test set, the 
Change Detection Report dialog box opens directly. If the flow or test 
appears in more than one test set, but was already resolved and rerun from 
one test set, the last results will open.

 2 Select from the Test Set and Test Instance lists to define which report you 
want to open. For more information, see “Understanding the Select Test Set 
Dialog Box” on page 82. Click OK. The Change Detection Report dialog box 
opens.
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To open the Change Detection Report dialog box from the Test Lab 
module:

 1 In the Test Sets Tree, select the test set containing the test for which you 
want to open the Change Detection Report dialog box.

 2 Click the Execution Grid tab.

 3 In the Execution Grid tab, select the test for which you want to open the 
Change Detection Report dialog box.

 4 In the Last Run Result pane, click the link for the test in the Status column. 
The Change Detection Report dialog box opens.

Understanding the Change Detection Report
You view the results of a test run in change detection mode in the Change 
Detection Report dialog box. The Change Detection Report dialog box also 
enables you to resolve the detected changes.
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The Change Detection Report dialog box contains the following elements:

Element Description

Details area Located at the top of the Change Detection Report 
dialog box. Displays basic details about the test.

The pane contains the following fields:

➤ Test Name. The name of the test.

➤ Creation Date. The date on which the test was 
created.

➤ Owner. The user who is the current owner of the 
test.

➤ Test Status. The status of the test run. The 
following statuses are possible:

➤ Passed. The test run passed and no changes 
were detected.

➤ Failed. The test run failed but no changes were 
detected.

➤ Passed with changes. The test run passed 
but changes were detected.

➤ Failed with changes. The test run failed 
changes were detected.

➤ Run started. The date and time on which the test 
run was executed.

➤ Run ended. The date and time on which the test 
run ended.

Status area Located at the top of the Change Detection Report 
dialog box, under the Details pane.

➤ Business Components. Graphically displays the 
number of business components in the test, and 
the breakdown of these components by their 
status. You can click a component status to filter 
the changes tree to show only components with 
that status.

➤ Resolved. Displays the number of components 
that have been resolved from the total 
components in the test. Click the Start 
Resolution button to resolve components.
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Changes tree Located at the left of the Entities area. Displays a 
hierarchical representation of your test, flows, 
business components, and component steps.

You can filter the Status or the Resolved column by 
clicking the Set Filter button  for the column 
and selecting the values you want to display. To 
clear the filters, click the Clear Filter button  .

The following columns are displayed.

➤ Entity Name. The name of the test, flow, business 
component, or step.

➤ Status. The status of the entity. The following 
statuses are possible:

➤  The entity passed and no changes were 
detected.

➤  The entity failed but no changes were 
detected.

➤  The entity passed, but changes were 
detected.

➤  The entity failed, and changes were 
detected.

➤ Resolved. For an entity in the changes tree with 
associated changes, displays Y if the changes were 
resolved and N if the changes were not resolved. 
If there are no changes associated with the node, 
--- is displayed.

Entity details Located at the top right of the Entities area.

Displays details of the entity selected in the changes 
tree. 

Changes tab Located at the bottom right of the Entities pane.

Displays a description of any changes detected in 
selected component, flow, or step, and offers 
possible resolutions. For more information on 
resolving changes, see “Resolving Changes” on 
page 83.

Element Description
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Used by tab Located at the bottom right of the Change 
Detection Report dialog box.

For a flow, displays the tests in which the flow is 
used. For a component, displays the tests and flows 
in which the component is used.

Screenshot tab Located at the bottom right of the Change 
Detection Report dialog box. Displayed only for 
components that have changes detected.

Displays a screenshot of your application for the 
selected component in the flow before and after the 
change. For a step, displays the screenshots for the 
component containing the step.

Save Closes the Change Detection Report dialog box and 
implements the change resolutions that you 
selected.

Cancel Closes the Change Detection Report dialog box 
without implementing the change resolutions that 
you selected.

Element Description
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Understanding the Select Test Set Dialog Box
The Select Test Set dialog box enables you to specify a flow or business 
process test. 

The Select Test Set dialog box contains the following lists:

List Description

Test The list of tests containing the flow. If the flow is 
included in a test set directly and not from within a 
test, <directly> appears is displayed as choice in the 
Test list. Displayed only if the flow is included in 
more than one test set in the Test Lab module.

Test Set ➤ For flows. The list of test sets containing the test 
selected in the Test list. If <directly> is selected in 
the Test list, the Test Set list includes only those 
test sets that include the flow directly and not 
from within a test.

➤ For business process tests. The list of test sets 
that include the test you selected.

Test Instance The list of instances of the flow or business process 
test in the test set selected in the Test Set list.
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Considerations for Working with the Select Test Set Dialog Box 
when Detecting Changes

When working with the Select Test Set dialog box when detecting changes, 
consider the following:

➤ If a flow is not contained in any test set it is added directly to the default test 
set in the Unattached folder and the Select Test Set Dialog box does not 
open and the Automatic Runner dialog box opens instead.

➤ If a flow is not contained directly in any test set but only as part of a test, it 
is automatically added directly to the default test set in the Unattached 
folder.

➤ If a flow is included only once in one test set and it is included directly and 
not from within a test, the Select Test Set dialog box does not open and the 
Automatic Runner dialog box opens instead.

Resolving Changes

You can resolve the changes detected by Business Process Testing for SAP 
Applications when running business process tests in change detection 
mode. The resolution options depend on the type of change detected, and 
may include opening a defect, and adding, removing, or modifying business 
components and flows in the test.

Note: To resolve changes, a user must belong to a user group that has 
permissions for the Modify Test and the Modify Component tasks. For more 
information on configuring user group permission settings, refer to the 
HP Quality Center Administrator’s Guide.
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To resolve changes:

 1 Open the Change Detection Report dialog box. For more information on 
opening the Change Detection Report dialog box, see “Viewing Change 
Detection Results” on page 76.

 2 Click the Start Resolution button. The first element in the changes tree with 
a detected change is selected.

 3 In the Changes tab, under Resolve, select the change resolution you want to 
use. The following resolutions are available for all changes:

➤ Ignore and mark as resolved. Marks the change as resolved without 
taking any action to resolve it.

➤ Open a defect. Opens the New Defect dialog box, enabling you to open a 
defect for the change. Note that if you open a defect for a change, you 
can also select another resolution for the change. For more information 
on opening defects, see the HP Quality Center User’s Guide.

Note: If the change detected is that there are new objects in the screen or 
tab, when you select Ignore and mark as resolved or Open a defect, the new 
objects are inserted in the shared object repository for that screen or tab.

In addition, there may be additional possible resolutions, depending on the 
type of change. For a list of available change resolutions for each type of 
change, see “Changes and Resolutions” on page 85.

 4 Click the Execute button. The change is marked as resolved. Note that for 
change resolutions other than Open a defect, the resolution is not 
implemented until you click Save, as described in step 7.
84

84



Chapter 6 • Detecting and Resolving Changes
 5 Click the Next Change button to select the next node in the changes tree 
with a detected change that was not yet resolved.

 6 Repeat steps 3 to 5 until all changes in the test are resolved. You can view 
the number of changes resolved and the total number of changes in the 
Status pane, next to the Start Resolution button.

 7 Click the Save button. The Change Detection Results dialog box closes and 
your tests, flows, and business components are updated according to the 
resolutions you selected.

Changes and Resolutions

This section lists the possible changes detected for flows, business 
components, and component steps, and the resolutions offered by Business 
Process Testing for SAP Applications for each change type.

Note: In addition to the options described in this section, the resolutions 
Ignore and mark as resolved and Open a defect are always available. For 
more information on these resolutions, see “Resolving Changes” on 
page 83.
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Changes and Resolutions for Flows

Change Resolutions Offered

Unable to move to the 
screen corresponding to 
the component in the 
flow.

Set the status of the component to Maintenance. 
Changes the status of the previous component in 
the flow to Maintenance. This indicates that the 
component should be modified to reflect the 
change.  

Unable to run any step of 
a business component, 
causing the entire 
component to fail.

Set the status of the component to Maintenance. 
Changes the status of the component to 
Maintenance. This indicates that the component 
should be modified to reflect the change.

A screen corresponding to 
a component was 
removed.

➤ Remove the business component from the flow. 
Removes the component representing the 
removed screen from the current test or flow 
only.

➤ Remove the component from all flows. Removes 
the component representing the removed screen 
from all tests or flows in which it is used.

A new screen was 
encountered during the 
test run that was not in 
the original flow.

Set the status of the flow to Maintenance. Changes 
the status of the flow to Maintenance. This 
indicates that the flow should be modified to reflect 
the change. You may want to relearn the flow to 
include the new screen.
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Changes and Resolutions for Business Components

Changes and Resolutions for Steps

Change Resolutions Offered

New controls were added 
to the screen 
corresponding to the 
component.

Add the following selected steps. Add new steps to 
the component for the new controls. You can select 
the check boxes corresponding to the controls for 
which you want to add steps to the component.

Controls that require entering data, such as text 
boxes, are added before the last step of the 
component. Controls that do not require entering 
data, such as buttons, are added after the last step of 
the component. The steps are added with the 
default operations for the controls.

Change Resolutions Offered

The control corresponding 
to the step was removed 
from the screen.

Remove the step from the business component. 
Removes the step from the component.

The type of the control 
corresponding to the step 
changed.

Update the step. Updates the step to reflect the new 
control type.
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7
Working with Application Model Entities 
in Quality Center

The Application Model module enables you to manage a hierarchical 
representation of the entities in your SAP application. You can import 
entities from your SAP application, and add and modify application entities 
and folders. If your Quality Center server has a license for Business Process 
Testing and Business Process Testing for SAP Applications, you can associate 
application entities with flows or with business components, as well as tests.

This chapter includes:

 ➤  About Working with the Application Model Entities in Quality Center 
on page 90

 ➤  Viewing Application Entities on page 91

 ➤  Importing the SAP Application Hierarchy on page 93

 ➤  Adding Folders and Application Entities Manually on page 95

 ➤  Modifying Folders and Application Entities on page 97

 ➤  Associating Application Entities with Tests and Flows on page 99

 ➤  Associating Application Entities with Business Components on page 103
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About Working with the Application Model Entities in 
Quality Center

You use the Application Model module to manage a representation of your 
SAP application components and entities. For example, if you link your SAP 
application components and application entities to tests or flows, you can 
see which tests or flows you need to run when changes affecting these 
components and entities are made in your application.

You can import SAP application components and application entities 
directly from your SAP application, or you can add and modify them 
manually.When you import directly from your SAP application, the 
hierarchy of the elements in the application and the basic data for each 
business entity are preserved. If you want to extend the scope at any stage, 
you can import the application hierarchy again, without overwriting 
existing entities in the Application Model module. If you choose to 
manually add and modify application entities, corresponding application 
entities in your SAP application are not affected. 

After you develop your application model tree, you can associate each 
application entity with tests in the Test Plan module. You can also associate 
an application entity with a business component or flow. Each business 
process test containing that business component or flow is then associated 
with all of the application entities associated with that component or flow. 
When you learn a flow automatically, the components created are 
automatically associated with related application entities in the Application 
Model module.

Note: You can customize permission settings for the Application Model 
module. You can also customize application entities and application entity 
folders. For more information, refer to the HP Business Process Testing for SAP 
Applications Installation Guide.
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Viewing Application Entities

You import, add, and modify application entities using the Application 
Model module. To open the Application Model module, click the 
Application Model button on the sidebar. 

You can view your application entities in the Application Model tree or the 
Application Model Grid.

The Application Model Tree
You can view a hierarchical representation of your application entities in the 
application model tree. To view the application model tree, select View > 
Application Model Tree.

Each folder item  in the application model tree represents an SAP 
application component in your SAP application. Each application entity 
item  represents an application entity in your SAP application.
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The Application Model Grid
You can view all the application entities in a Quality Center project from the 
Application Model Grid. Each row displays a separate application entity. 
Each column represents a separate data item. To view the Application Model 
Grid, select View > Application Model Grid. 

The following columns are displayed for each entity:

Column Description

Application The SAP application in which the application entity is 
located.

Code The code of the entity in the SAP application.

Description The description of the entity in the SAP application.

Entity ID A unique numerical ID assigned by Quality Center to the 
application entity. This ID cannot be modified.

Entity Name The name of the entity in the SAP application.

Folder The folder in the application model tree in which the 
application entity is located. Each folder represents an 
SAP application element. 
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Importing the SAP Application Hierarchy

You can import the application hierarchy to the Application Model module. 
This maps the entities in your SAP application to application entities in the 
Application Model module, reproducing the same hierarchical structure. 
Each SAP application element is represented as a folder. Each folder contains 
representations of the application entities that are included in the SAP 
application element in your SAP application. 

You can import the application hierarchy more than once. For example, if 
you add new entities to your SAP application, you may want to include 
them in the application hierarchy, or you may decide to include application 
entities that were previously out of scope. When you import application 
entities that are already in the Application Model module, the data that you 
entered for each application entity is not overwritten. Any associations you 
created with tests, flows, and business components are also preserved.

Is Active This column is relevant only for Change Impact Testing 
module for SAP applications. For more information, see 
the HP Change Impact Testing module for SAP applications 
User’s Guide. 

Modified The date and time when the application entity was last 
modified.

Type The type of SAP application entity, for example, SAP 
Transaction. 

Column Description
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To import the application hierarchy:

 1 In the Application Model module, display the application model tree and 
select Application Entities > Import Application Model. The SAP Login 
Details dialog box opens.

 2 Type the login details for your SAP application and click Next. 
Quality Center connects to your SAP application and the Select Application 
Components dialog box opens, displaying the SAP components in your SAP 
application. (You can view the same hierarchy in your SAP application using 
the SE81 transaction.)
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 3 Select the SAP application elements you want to import to the Application 
Model module. When these application components are imported, all child 
application entities are also imported. Note that you can also import user 
transactions that are not assigned to any application element. To import 
these transactions, select the User Transactions (Unassigned) node in the 
Select Application Components dialog box. Click Next.

 4 Click Import to import the SAP components and application entities to the 
Application Model module. Note that this process may take some time. 
When the import process is finished, a confirmation message displays. Click 
OK.

 5 Click Close to close the Import Application Model Wizard.

The application components you selected are imported to the Application 
Model module. The hierarchical structure of the SAP application 
components is reproduced in the Application Model module, with the 
top-level components located under the SAP folder.

Adding Folders and Application Entities Manually

You can add folder and application entities manually.

Tip: You can also import folders and application entities using the SAP 
Import wizard. For more information, see “Importing the SAP Application 
Hierarchy” on page 93.
95

95



Chapter 7 • Working with Application Model Entities in Quality Center
To add a folder:

 1 In the application model tree, select a folder and click the New Folder 
button, or select Application Entities > New Folder. The New Folder dialog 
box opens.

 2 In the Folder Name box, type a name for the folder and click OK. The new 
folder is added to the application model tree under the folder you selected 
in step 1.

 3 You can add a description for the new folder in the Description tab in the 
right pane.

 4 You can add an attachment to the new folder in the Attachments tab. For 
more information on adding attachments, see the HP Quality Center User’s 
Guide.

To add an application entity:

 1 In the application model tree, select a folder and click the New Entity 
button, or select Application Entities > New Entity. The New Application 
Entity dialog box opens.
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 2 In the Application Entity Name box, type the name of the application entity. 
This is a required field.

 3 In the Application Entity Code box, type the unique code of the application 
entity. This is a required field.

 4 In the Description box, type a description of the application entity.

 5 Click OK. The new application entity is added to the application model tree 
under the folder you selected in step 1.

Modifying Folders and Application Entities

You can rename and delete folders and application entities in the 
Application Model module.

Renaming Folders and Application Entities
You can rename a folder or application entity in the Application Model 
module.

To rename a folder or application entity:

➤ To rename a folder or application entity in the application model tree, select 
a folder or application entity and select Edit > Rename. Alternatively, 
right-click the folder or application entity and select Rename. Edit the name 
and press ENTER.

➤ To rename an application entity in the Application Model Grid, click the 
name of the application entity and type the new name.

Deleting Folders and Application Entities
You can delete a folder or application entity from the application model 
tree. When you delete a folder, you can choose to delete the folder and its 
subfolders, or you can choose to delete the folder, its subfolders, and 
application entities. 
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➤ If you delete a folder with its subfolders, all of the application entities are 
moved to the Unattached folder in the application model tree. 

➤ If you delete a folder with its subfolders and application entities, all 
subfolders and application entities under the selected folder are deleted 
permanently. 

To delete a folder:

 1 Select a folder from the application model tree.

 2 Click the Delete button, or select Edit > Delete. Alternatively, right-click the 
folder and select Delete. The Confirm Delete Folder dialog box opens.

 3 Select Delete folders only or Delete folders and application entities.

 4 Click Yes.

To delete an application entity:

 1 Select an application entity from the application model tree or Application 
Model Grid.

 2 Click the Delete button, or select Edit > Delete. Alternatively, right-click the 
application entity and select Delete.

 3 Click Yes to confirm.
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Associating Application Entities with Tests and Flows 

You can associate the application entities you created in the Application 
Model module with tests and flows from the Test Plan module. You can 
perform this task from the Application Model module or from the Test Plan 
module.

Associating Application Entities with Tests or Flows Using 
the Application Model Module
You can associate application entities with tests or flows using the 
Application Model module.

To associate application entities with tests or flows using the Application 
Model module:

 1 In the application model tree, select an application entity and click the 
Linked Tests tab. The Linked Tests tab displays the coverage grid for the 
selected application entity.

For information on the columns in the Linked Tests tab, see the 
HP Quality Center User’s Guide.
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 2 In the Linked Tests tab, click the Select Tests button to show the test plan 
tree on the right.

 3 To search for a specific test or flow in the tree, type the name (or part of the 
name) of the test or flow in the Find box and click the Find button. If the 
search is successful, the test or flow is highlighted in the tree.

 4 To refresh all of the tests and flows in the test plan tree, click the Refresh All 
button.

 5 Select a test, test folder, or flow to add to the application entity’s test 
coverage. Click the Link Tests To Application Entity button. The test or flow 
is added to the coverage grid.

 6 To refresh the application entities in the coverage grid, click the Refresh All 
button.

 7 To filter the application entities displayed in the coverage grid, choose one 
of the following options from the Show Entities box:

➤ Linked Directly. Displays only those tests or flows that are associated 
directly with the application entity.

➤ Linked Through Other Assets. Displays those tests that are associated 
with the application entity via business components or flows, and flows 
that are associated with the application entity via business components.

➤ All. Displays all of the application entities that are associated with the 
test or flow. 
100

100



Chapter 7 • Working with Application Model Entities in Quality Center
 8 Click the Close button to hide the test plan tree.

Notes: 

➤ To modify the data in the coverage grid columns or to remove tests or 
flows from the coverage grid, you must first select Linked Directly in the 
Show Entities box.

➤ To remove test or flow coverage from the Application Model module, 
verify that Linked Directly is displayed in the Show Entities box. Then 
select the test or flow you want to remove from coverage and click the 
Remove Link button. Click Yes to confirm.

Associating Application Entities with Tests or Flows Using 
the Test Plan Module
You can associate application entities with tests or flows using the Test Plan 
module.

To associate application entities with tests using the Test Plan module:

 1 In the test plan tree, select the test or flow you want to associate with one or 
more entities, and click the Application Entities tab. The application entities 
associated with the selected test or flow are displayed.
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 2 In the Application Entities tab, click the Select Application Entities button 
to show the application model tree on the right.

 3 To search for a specific application entity in the tree, type the name (or part 
of the name) of the application entity in the Find box and click the Find 
button. If the search is successful, the application entity is highlighted in 
the tree.

 4 To refresh all of the application entities in the application model tree, click 
the Refresh All button.

 5 Select an application entity or application folder to add to the application 
entity coverage for the test or flow. Click the Add Entity to Linkage button. 
The application entity is added to the coverage grid.

 6 To refresh the application entities in the coverage grid, click the Refresh All 
button.

 7 To filter the application entities displayed in the coverage grid, choose one 
of the following options from the Show Entities box:

➤ Linked Directly. Displays only those application entities that are 
associated directly with the test or flow.

➤ Linked Through Other Assets. Displays those application entities that 
are associated with business components via business process tests or 
flows, or are associated with flows via business process tests.

➤ All. Displays all of the application entities that are associated with the 
test or flow. 
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 8 Click the Close button to hide the application model tree.

Notes: 

➤ To modify the data in the coverage grid columns or to remove 
application entities from the coverage grid, you must first select Linked 
Directly in the Show Entities box.

➤ To remove application entity coverage from the Test Plan module, verify 
that Linked Directly is displayed in the Show Entities box. Then select the 
application entity you want to remove from coverage and click the 
Remove Link button. Click Yes to confirm.

Associating Application Entities with Business Components

In addition to associating application entities with tests and flows, you can 
associate application entities directly with a business component. This 
automatically associates the application entity with every business process 
test and flow containing that business component. For details on including 
business components in a business process test, see the HP Business Process 
Testing User’s Guide.

You associate application entities with business components using the 
Business Components module. After they are associated, you can manage 
your associated application entities either from the Application Model 
module or from the Business Components module.

Note: When you learn a flow automatically, business components created 
are automatically associated with related application entities in the 
Application Model module.
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To associate application entities with business components:

 1 In the component tree, select the component you want to associate with 
one or more application entities, and click the Application Entities tab. The 
application entities associated with the selected business component are 
displayed. For a description of each column displayed, see “The Application 
Model Grid” on page 92.

 2 In the Application Entities tab, click the Select Application Entities button 
to show the application model tree on the right.

 3 To search for a specific application entity in the tree, type the name (or part 
of the name) of the application entity in the Find box and click the Find 
button. If the search is successful, the application entity is highlighted in 
the tree.

 4 To refresh all of the application entities in the application model tree, click 
the Refresh All button.

 5 Select an application entity or application folder to add to the business 
component’s application entity coverage. Click the Add Entity to Linkage 
button. The test is added to the coverage grid.

 6 Click the Close button to hide the application model tree.

Note: To remove application entity associations from the Business 
Components module, select the application entity for which you want to 
remove an association, click the Remove Link button, and click Yes to 
confirm.
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